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Introduction to document types 
and metadata

Metadata attached to documents can be used in different types of scenarios, for 
example to:

• Search for documents in databases.

• Write personalized texts in Composition Center.

• Create business rules in Composition Center.

• Sort and envelope documents.

In Design Center, you can specify the metadata to add to invoices, orders, etc. To 
do this, you create document type resources that contain the metadata (one 
document type resource for each type of document), and connect the document 
type resources to the appropriate Design Center objects (Message or output 
connector in runtime configuration).

Figure 1 Connecting metadata to a Message
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Introduction to document types and metadata
About document types and metadata
In this section

• Metadata group resources on page 8

• Document type resources on page 9

• Unique document type and metadata identifiers on page 13

• Document type revisions on page 13

• Do not use more metadata than you need on page 14

Metadata group resources
A metadata group resource contains a specific class of metadata. For example, a 
metadata group resource can contain customer related metadata, such as customer 
name and customer number.

Figure 2 Metadata group with three metadata

Metadata name and type

When you add metadata to a metadata group resource you must specify the 
metadata name and type. The metadata name should be descriptive and unique, 
and the metadata type must conform to the type of data it is intended for – 
Numeric, Date, or Text. 

Metadata values

You do not assign values to metadata in the metadata group. Metadata values are 
assigned per document type.
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Introduction to document types and metadata
Connecting metadata to document types

When you create a metadata group resource, you must specify which document 
types to connect it to.

Figure 3 Metadata group connected to two document types

To enable the use of metadata in shared Composition Center resources (text and 
reusable rules), you must add the metadata group to all document types used in 
Composition Center.

Document type resources
A document type resource contains all the metadata to attach to a specific 
document type (invoice, order, etc.). 

Metadata names and types are defined in a number of metadata groups, and each 
metadata group is connected to the appropriate document type resources. In each 
document type resource you specify the following:

• The values of the metadata when used in the document type. See Metadata 
values on page 9.

• In which contexts to enable metadata. See Document type contexts on page 
11.

Metadata values
Metadata values are assigned per document type.
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Introduction to document types and metadata
Static text or variable metadata values

You can use static text or variables as metadata values. Variable values are 
retrieved from Event or script defined variables. Static text values are values that 
you enter directly in the document type resource. Note that dollar signs ($) cannot 
be used in static text values.

There is also an option to select No value for a metadata. This option is used with 
E-Invoice Center where metadata values are assigned by filters.

Note: The values must conform to the data type specified for the metadata in the 
metadata group resource, i.e. Numeric, Date, or Text.

Using data type Date

Date values must follow the ISO 8601 standard. Local time with offset to UTC 
(Coordinated Universal Time) is not supported. Examples of ISO 8601 date 
values are shown in the table below.

Using data type Numeric

The following apply to numeric values:

• Period must be used as decimal separator.

• The maximum number of decimal digits that can be used to the left of the 
decimal separator is 15.

• The maximum number of decimal digits that can be used to the right of the 
decimal separator is 8.

• The maximum number of decimal digits that can be used in total, to both the 
left and the right of the decimal separator, is 15.

You can use the IsNum scripting function to validate numeric values.

Using data type Text

Text values can contain any alphanumeric character.

Calendar date YYYY-MM-DD 

For example: 2010-05-20

You can use the IsDate and Dformat scripting functions 
to validate and format the value.

Date and time YYYY-MM-DDThh:mm:ss

For example: 2010-05-20T13:04:25

You can use the DtisoFormat scripting function to 
validate and format the value.
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Introduction to document types and metadata
Different metadata values in different document types

If several document types use the same metadata group, you can assign different 
metadata values in the document types.

Figure 4 Document types with different values in shared “Metadata group 1”

Document type contexts
Document types can be used in different contexts:

• Archive context

• Message context

• Post-processing context

You must specify which metadata to enable and use in each context.

Figure 5 Metadata (MD1, MD2, etc.) enabled in different contexts

Archive context

In Archive context you specify which metadata to store in the StreamServe 
archive, and to use in StreamStudio Collector to search for documents in the 
StreamServe archive.

In this context, you also have the option to store the following predefined system 
metadata:

External Job ID This metadata must be set by the SetExtJobId 
scripting function. It can be used to identify 
documents related to specific input jobs. 
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Introduction to document types and metadata
Message context

In Message context you specify which metadata to store in Message storages in 
the runtime repository. This metadata can be used by Correspondence Reviewer 
and other web services that use the WSDocument API:s.

In this context, you also have the option to store the predefined system metadata 
External Job ID. 

Post-processing context

In Post-processing context you specify which metadata to store in Post-
processing storages in the runtime repository. The metadata can be used when 
post-processing documents (enveloping and sorting).

In this context, you also have the option to store the predefined system metadata 
External Job ID. 

Receiver This metadata is set in the runtime output connector 
settings in Design Center. It can be used to identify 
documents related to a specific receiver.

Sender This metadata is set in the runtime job settings in 
Design Center. It can be used to identify documents 
related to a specific sender.

Expiring date time Date and time the document expires, and is ready to 
be removed from the archive.

Tracker ID The globally unique identifier (GUID) of the top job. 

Application domain ID Implemented for future use and not used in this 
release.
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Introduction to document types and metadata
Unique document type and metadata identifiers
Document types, metadata groups, and metadata are identified by Globally 
Unique IDentifiers (GUIDs), and not by names, in the repositories. This ensures 
that all document types etc. in the repositories will have unique identifiers.

Figure 6 GUIDs for document type (Document Type X), Metadata group 
(Metadata group X), and metadata (Customer number)

If you, for example, delete a metadata, and then create a new metadata with the 
same name, the new metadata will get a different GUID than the old metadata – 
even though the name is the same. This will most likely cause problems when you 
redeploy your Project.

For information on how to display the GUIDs in Design Center, see Metadata 
Group Editor on page 53 and Document Type Editor – overview on page 56.

Document type revisions
When you change the information in a document type, for example add new 
metadata, the document type revision number is increased.

When you deploy a Project that contains an updated document type, Control 
Center generates a warning. In this warning you can see the difference between 
the current document type in the enterprise repository and the document type you 
intend to deploy. You can then decide whether to continue to deploy the Project 
or cancel. If you deploy, the enterprise repository is updated with the new revision 
of the document type.

You must never copy document type or metadata group resource files 
(*.dcres). If you do so, the GUIDs are copied and the identifiers are 
no longer unique. 
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Introduction to document types and metadata
If you change the information in a document type resource in a global resource 
set, all Design Center Projects that contain the updated document type are 
affected. This means you must check out the latest revision of the document type 
before you deploy a Project. If you try to deploy a Project where the document 
type has a lower document revision than the document type stored in the 
enterprise repository, deployment fails.

Do not use more metadata than you need
To save space in the repositories, and to improve search performance, you should 
not use more metadata than you really need. The maximum limit is 750 metadata 
per document type.
StreamServe Persuasion SP5 Document types and metadata User Guide Rev A
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Introduction to document types and metadata
Deployed document types and metadata
Document types and metadata are configured in Design Center as described in the 
previous sections. When a Project is exported and deployed to a StreamServer 
application, all document types are stored the enterprise repository. 

Figure 7 Document types added to enterprise repository

A schematic example of a document type stored in the enterprise repository is 
illustrated below.

<?xml version="1.0"?>

<documentType ... name="doctypeInvoice" guid="..." revision="2">

  <metadataGroup name="STATIC" guid="STATIC">

    <metadataTypes>

      <metadata name="..." scope="..." type="..." guid="..." 

      archived="false" message="false" default="true" postprocess="false"/>

      ...

    </metadataTypes>

  </metadataGroup>

  <metadataGroup name="Customer Data" guid="...">

    <metadataTypes>

      <metadata name="Customer Number" scope="" type="xs:double" guid="..." 

      archived="true" message="false" default="true" postprocess="false"/>

      <metadata name="Customer Name" scope="" type="xs:string" guid="..." 

      archived="true" message="false" default="true" postprocess="false"/>

    </metadataTypes>

  </metadataGroup>

</documentType>
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Introduction to document types and metadata
The document types stored in the enterprise repository are the “master document 
types” that determine which document type and metadata information to store in 
the runtime repositories and StreamServe archives.

When deploying, the document type information in the exported Project is 
checked against the document type information stored in the enterprise 
repository. If any document types are modified before the export, a warning is 
issued before the document types are updated in the enterprise repository.

Document types in runtime repositories
StreamStudio applications, other web services, and Post-processors use the 
document types and metadata in the runtime repository. All document types and 
metadata are retrieved from the enterprise repository, and stored in the runtime 
repository when the StreamServer application is started.

Figure 8 Document types added to runtime repository

If new document type and metadata information is added to the enterprise 
repository, the corresponding information is added to the runtime repository when 
the StreamServer application is started. If existing metadata is updated in the 
enterprise repository, the corresponding information is updated in the runtime 
repository when the StreamServer application is started.
StreamServe Persuasion SP5 Document types and metadata User Guide Rev A
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Introduction to document types and metadata
Document types in StreamServe archives
StreamStudio Collector uses document types and metadata definitions in a 
StreamServe archive when searching for documents stored in the same 
StreamServe archive. All document types and metadata are retrieved from the 
enterprise repository, and stored in the StreamServe archive when the Archiver 
application is started.

Figure 9 Document types added to StreamServe archive

If new document type and metadata information is added to the enterprise 
repository, the corresponding information is added to the StreamServe archive 
when the Archiver application is started. If existing metadata is updated in the 
enterprise repository, the corresponding information is updated in the 
StreamServe archive when the Archiver application is started.
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Introduction to document types and metadata
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Creating document types and 
metadata groups

To be able to attach metadata to documents processed by StreamServer, you must 
create metadata group resources and document type resources. You add metadata 
to the metadata groups, and connect the appropriate metadata groups to the 
document type resources.

Figure 10 Metadata, metadata groups, and document types

Do not use more metadata than you need

To save space in the databases, and improve search performance, you should not 
use more metadata than you really need. The maximum limit is 750 metadata per 
document type.
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Creating document types and metadata groups
Global resource set

You must create a global resource set for all document types and metadata groups 
used within an organization. This ensures that all document types, metadata 
groups, and metadata are unique.

Figure 11 Global resource set used by all Design Center Projects

To create a global resource set, you can create a separate Design Center Project, 
and create the global resource set in this Project. You then add the global resource 
set to all your Design Center Projects. In each Project, you connect the document 
type resources to the appropriate Message configurations and Runtime 
configurations. For example, connect an Invoice document type resource to a 
Message configuration that produces invoices, and an Order document type 
resource to a Message configuration that produces orders.

To add a global resource set to a Design Center Project

1 In Design Center, select File > Add to Project. The Add to Project dialog 
box opens.

2 Click Browse. A file browser opens.

3 Browse to and select the global resource set. The global resource set is 
added to your Project.

To connect the global resource set to a Message/Runtime configu-
ration

1 Right-click the Message/Runtime configuration view and select Add 
Resource Set. The Select Resource Sets dialog box opens.

2 Select the global resource set and click OK. The global resource set is 
connected to the Message/Runtime configuration.
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Creating document types and metadata groups
Configuration procedures
1 Create document type resources. See Creating document type resources on 

page 21.

2 Create metadata group resources. See Creating metadata group resources 
on page 22.

3 Add metadata to the metadata group resources. See Adding metadata to a 
metadata group on page 22.

4 Connect metadata group resources to document type resources. See Adding 
metadata to document types on page 24.

5 Assign values to metadata (configured per document type resource). See 
Assigning values to metadata on page 25.

6 Enable/disable metadata in different contexts (configured per document 
type resource). See Enabling metadata in different contexts on page 25.

7 Connect document type resources to documents. See Connecting document 
type resources to documents on page 26.

Creating document type resources
When you create the global resource set for document type resources and 
metadata group resources you can start with the document type resources. At this 
stage, you can only create empty document type resources since there is no 
metadata defined. Later, when you have created metadata groups and connected 
the metadata groups to the appropriate document type resources, you can:

• Assign values to the metadata (see Assigning values to metadata on page 
25).

• Specify in which contexts to enable metadata (see Enabling metadata in 
different contexts on page 25).

Names for document type resources

• Document type names must be unique.

• Document type names should be descriptive.

• Do not include white space in document type names.

• For information about the maximum number of characters and invalid 
characters in document type names, see Naming Project components in the 
Design Center documentation.

You must never copy document type resource files (*.dcres). If you 
do so, the GUIDs are copied and the identifiers are no longer unique. 
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Creating document types and metadata groups
To create a document type resource

1 In the resource set, right-click the appropriate node and select New > 
Document Type. A new document type is added to the resource set.

2 Rename the document type.

Creating metadata group resources
You can create metadata group resources where you include specific classes of 
metadata. For example, create a metadata group resource that contains customer 
metadata such as customer name and customer number, create another metadata 
group resource that contains company metadata, and so on. First you create the 
metadata group resource. Then you add the metadata to the metadata group (see 
Adding metadata to a metadata group on page 22), and connect the metadata 
group to the appropriate document type resources (see Adding metadata to 
document types on page 24).

Names for metadata groups

For information about the maximum number of characters and invalid characters 
in metadata group names, see Naming Project components in the Design Center 
documentation.

Note: For readability reasons in Composition Center, names should be shorter 
than 20 characters.

To create a metadata group

1 In the resource set, right-click the appropriate node and select New > 
Metadata Group. A new metadata group is added to the resource set.

2 Rename the metadata group.

Adding metadata to a metadata group
When you have created a metadata group resource you can add metadata to it. 
When you add metadata you only specify the name and data type of the metadata 
– metadata values are assigned per document type (see Assigning values to 
metadata on page 25).

Do not add too much metadata to a metadata group

You should try to create small metadata groups containing only metadata relevant 
to all the document types that share the metadata group.

You must never copy metadata group resource files (*.dcres). If you 
do so, the GUIDs are copied and the identifiers are no longer unique. 
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Creating document types and metadata groups
If you add a large number of metadata to a metadata group, irrelevant metadata 
might be connected to some of the document types that share the same metadata 
group. 

Names for metadata

• Metadata names should be globally unique. This means you should not use 
the same metadata name for metadata in different metadata groups.

• Metadata names should be descriptive since they are displayed to business 
users in StreamStudio.

• For readability reasons in Composition Center, names should be shorter 
than 20 characters.

Data types

You must select the appropriate data type – Date, Numeric, or Text – when you 
add a metadata. The data type must conform to the type of data the metadata is 
intended for.

To add a metadata to a metadata group

1 In the resource set, double-click the metadata group. The Metadata group 
editor opens.

2 Click . The Metadata definition dialog box opens.

3 Add a unique and descriptive Metadata name.

4 Select the appropriate Data type and click OK.
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Creating document types and metadata groups
Adding metadata to document types
When you create a metadata group resource, you must specify which document 
type resources to connect the metadata group to.

Figure 12 Connecting a metadata group to two document types

You can manually select one or more existing document type resources in the 
same resource set as the metadata group. You can also select the option Auto-
apply to all Document types to connect the metadata group to all document type 
resources in the resource set. By selecting this option, the metadata group is 
automatically connected to each new document type you create in the resource 
set.

To connect a metadata group to existing document types

1 In the resource set, double-click the metadata group. The Metadata group 
editor opens.

2 Click Share. The Document types view opens.

3 In the Document type list, select all document types to connect the 
metadata group to.

4 Click OK.

To connect a metadata group to existing and future document types

1 In the resource set, double-click the metadata group. The Metadata group 
editor opens.

2 Click Share. The Document types view opens.

3 Select Auto-apply to all Document types and click OK.
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Creating document types and metadata groups
Enabling metadata in reusable Composition Center resources
If metadata in a metadata group will be used in reusable Composition Center 
resources (text and rules), you must connect the metadata group to all document 
types used in Composition Center. In this circumstance it is recommended to 
select the option Auto-apply to all Document types when you connect the 
metadata group to document type resources.

Assigning values to metadata
Metadata values are assigned per document type. This means you can assign 
different values to metadata in the document types that share the same metadata 
group. See Metadata values on page 9 for more information about metadata 
values.

To assign values to metadata

1 In the resource set, double-click the document type. The Document Type 
editor opens.

2 In the Metadata groups list, select the metadata group to configure.

3 In the Value assignments table, select the first metadata to assign a value 
to.

4 Select whether to use No value, Static text, or Variable.

5 Enter the Value.

Enabling metadata in different contexts
A document type is divided into different contexts (see Document type contexts 
on page 11). You must specify which metadata to enable in each context.

To enable metadata in a context

1 In the resource set, double-click the document type. The Document Type 
editor opens.

2 In the Metadata groups list, select the metadata group to configure. All 
metadata in the group is displayed in the Value assignments table.

3 From the Context drop-down list, select the context (Archive, Message, or 
Post-processing).

4 In the Value assignments table, select all the metadata to enable.
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Creating document types and metadata groups
Connecting document type resources to documents
You must connect document type resources to the appropriate objects in your 
Design Center Projects. Document types used in Archive context or Post-
processing context must be connected to an output connector (in runtime 
configuration). Document types used in any other context must be connected to a 
Message.

To connect a document type resource to a Message

1 Right-click the Message configuration view and select Set Document 
Type. The resource browser opens.

2 Browse to and double-click the document type you want to connect. The 
document type resource is connected.

To connect a document type resource – Archive context

1 In the Runtime configuration view, open the output connector settings 
dialog box (generic layer).

2 Depending on the output mode, select either Process Begin, Document 
Begin, or Job Begin.

3 Click the Archiving tab.

4 Browse to and double-click the document type you want to connect. The 
document type resource is connected.

To connect a document type resource – Post-processing context

1 In the Runtime configuration view, open the output connector settings 
dialog box (generic layer).

2 Select Document Begin.

3 Click the Document Type tab.

4 Browse to and double-click the document type you want to connect. The 
document type resource is connected.
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Modifying metadata groups and 
document types

As long as no document type is deployed to the enterprise repository, you can 
modify the metadata groups and document type resources at any time. 

If you modify a document type after it has been deployed – this also applies to 
modifying any of the metadata groups included – the repositories are affected by 
the changes. This means the applications that use the document type information 
in the repositories may be affected by the changes. See Consequences of 
redeploying modified document types on page 35 for more information.

In this chapter

• Modifying metadata groups on page 27

• Modifying document type resources on page 32

• Consequences of redeploying modified document types on page 35

Modifying metadata groups
In this section

• Renaming metadata groups on page 27

• Adding new metadata on page 28

• Renaming metadata on page 28

• Changing the data type of metadata on page 29

• Deleting metadata on page 29

• Deleting metadata groups on page 30

• Removing a metadata group from document type resources on page 31

Renaming metadata groups
When you rename a metadata group (see Names for metadata groups on page 22 
for valid names), all connected document type resources are updated with the new 
metadata group name.

Right-click the metadata group resource and select Show 
Dependencies to see a list of all connected document type resources.
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Modifying metadata groups and document types
To rename a metadata group

1 In the resource set, right-click the metadata group and select Rename.

2 Enter the new name and press ENTER.

Consequences for deployed document types

See Renaming metadata groups (redeploy) on page 36.

Adding new metadata
When you add new metadata to a metadata group, the new metadata is added to 
all connected document type resources when you save the metadata group.

The new metadata have no values assigned in the document type resources, which 
means you must assign metadata values in all affected document types. See 
Editing metadata values on page 32.

To add a metadata to a metadata group

1 In the resource set, double-click the metadata group. The Metadata group 
editor opens.

2 Click . The Metadata definition dialog box opens.

3 Add a unique and descriptive Metadata name.

4 Select the appropriate Data type and click OK.

Consequences for deployed document types

See Adding new metadata (redeploy) on page 37.

Renaming metadata
When you rename metadata (see Names for metadata on page 23 for valid names) 
in a metadata group, the new metadata names are updated in all connected 
document type resources when you save the metadata group. 

Note: If you have used the metadata names in scripts, rule functions, etc., you 
must update the changed metadata names in the scripts, etc.

To rename metadata

1 In the resource set, double-click the metadata group. The Metadata group 
editor opens.

2 Double-click the metadata. The Metadata definition dialog box opens.

3 Change the Metadata name and click OK.

Consequences for deployed document types

See Renaming metadata (redeploy) on page 38.
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Modifying metadata groups and document types
Changing the data type of metadata
You can change the type of a metadata as long as you have not deployed any 
document type that contains the metadata.

When you save a metadata group, the metadata types are automatically updated 
in all connected document type resources. The metadata values in the document 
type resources are not affected.

To change the data type of a metadata

1 In the resource set, double-click the metadata group. The Metadata group 
editor opens.

2 Double-click the metadata to edit. The Metadata definition dialog box 
opens.

3 Change the Data type and click OK.

Consequences for deployed document types

Deleting metadata
You can delete metadata in a metadata group as long as you have not deployed 
any document type that contains the metadata group. When you save the metadata 
group, the deleted metadata is removed from all connected document type 
resources. 

To delete a metadata

1 In the resource set, double-click the metadata group. The Metadata group 
editor opens.

2 Select the metadata to delete and click . An alert message pops up.

3 Click Yes to delete.

This change cannot be applied to a document type unless a user with 
administrator privileges updates the repositories. See:

• Changes that require database manipulation on page 44.

• Changing the data type of metadata (redeploy) on page 45.
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Consequences for deployed document types

Deleting metadata groups
If you delete a metadata group, i.e. remove it from the resource set, it is removed 
from all connected document type resources. This means all metadata in the 
deleted metadata group is removed from all document types that were connected 
to this metadata group.

To delete a metadata group

In the resource set, right-click the metadata group and select Delete. The metadata 
group is removed from the resource set and all connected document type 
resources.

Consequences for deployed document types

Adding a metadata group to document type resources
If you need more metadata in a document type, you must add the metadata groups 
that contain this metadata.

To add a metadata group to a document type resource

1 In the resource set, double-click the metadata group. The Metadata group 
editor opens.

2 Click Share. The Document types view opens.

3 In the Document type list, select the document type and click OK.

Consequences for deployed document types

See Adding metadata groups (redeploy) on page 40.

This change cannot be applied to a document type unless a user with 
administrator privileges updates the repositories. See:

• Changes that require database manipulation on page 44.

• Deleting metadata (redeploy) on page 46.

This change cannot be applied to a document type unless a user with 
administrator privileges updates the repositories. See:

• Changes that require database manipulation on page 44.

• Deleting metadata groups (redeploy) on page 48.
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Removing a metadata group from document type 
resources

If you want to remove unused metadata from a document type resource, you must 
remove the metadata groups that contain this metadata. 

Note: If you remove a metadata group from a document type, you remove all 
metadata included in the metadata group.

To remove a metadata group from a document type resource

1 In the resource set, double-click the metadata group. The Metadata group 
editor opens.

2 Click Share. The Document types view opens.

3 In the Document type list, clear the document type and click OK.

Consequences for deployed document types

This change cannot be applied to a document type unless a user with 
administrator privileges updates the repositories. See:

• Changes that require database manipulation on page 44.

• Removing metadata groups (redeploy) on page 48.
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Modifying document type resources
In this section

• Renaming document type resources on page 32

• Editing metadata values on page 32

• Enabling/disabling metadata in a context on page 33

• Deleting document type resources on page 34

Renaming document type resources
When you rename a document type resource, all affected Message configurations 
and Runtime configurations are updated with the new document type name.

To rename a document type resource

1 In the resource set, right-click the document type resource and select 
Rename.

2 Enter the new name (see Names for document type resources on page 21) 
and press ENTER.

3 Reload the document type resource in the Design Center objects where it is 
used. See Connecting document type resources to documents on page 26.

Consequences for deployed document types

See Renaming document type resources (redeploy) on page 39.

Note: When you deploy after renaming a document type resource, you must 
make sure the option Clear data folder on deploy is enabled. This will 
clear all data in the ...\applications\<Application_Name>\data 
folder.

Editing metadata values
You can change the value assignment type (No value, Static text, or Variable) 
as well as the actual value assigned to the metadata. The changes you apply to a 
single document type do not affect any other document types.

Right-click the renamed document type resource and select Show 
Dependencies to see where the resource is used.

Note: You must check the dependencies in each Design Center 
Project and not in the Project containing the global resource set 
for the document type resources.
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To change a metadata value

1 In the resource set, double-click the document type resource. The document 
type editor opens.

2 In the Metadata groups list, select the metadata group that contains the 
metadata you want to edit.

3 In the Value assignments table, select the metadata.

4 Select whether to use No value, Static text, or Variable.

5 Enter the Value.

Consequences for deployed document types

You can change the value assignment type (No value, Static text, or Variable) as 
well as the actual value to assign to the metadata without affecting the repositories 
or StreamStudio applications.

Enabling/disabling metadata in a context
You can enable metadata in a context, i.e. change the metadata context in a 
document type from disabled to enabled. You can also disable metadata in a 
context (i.e. change from enabled to disabled) as long as you have not deployed 
the document type.

To enable/disable a metadata in a context

1 In the resource set, double-click the document type resource. The document 
type editor opens.

2 In the Metadata groups list, select the metadata group that contains the 
metadata.

3 From the Context drop-down list, select the context.

4 In the Value assignments table, enable/disable the metadata.

Consequences for deployed document types (enabling)

You can enable metadata in a context. See Enabling metadata in a context 
(redeploy) on page 41.
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Consequences for deployed document types (disabling)

Deleting document type resources
If you delete a document type resource, i.e. remove it from the resource set, it is 
removed from all Message configurations. If the document type also is used for 
post-processing or archiving, it is removed from the runtime output connector 
configuration. This means you must assign new document type resources to the 
Message and runtime output connector configurations 

To delete a document type resource

In the resource set, right-click the document type resource and select Delete. The 
document type is removed from the resource set and all affected Message 
configurations and runtime output connector configurations.

Consequences for deployed document types

See Deleting document type resources (redeploy) on page 42.

You cannot disable metadata in a context unless a user with 
administrator privileges updates the repositories. See:

• Changes that require database manipulation on page 44.

• Disabling metadata in a context (redeploy) on page 49.
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Consequences of redeploying modified 
document types

You must be aware of the consequences when you modify and redeploy a 
document type. This section describes different scenarios and what the 
consequences are.

Figure 13 Redeploying a modified document type

When deployment is not allowed

In the following situations, a document type cannot be redeployed unless data is 
updated in the repositories by a user with special privileges:

• When the metadata type is changed.

• When metadata is removed:

– Metadata deleted (removed from metadata group).

– Metadata groups removed from a document type.

– Metadata group deleted (removed from the resource set).

• When metadata is disabled in a context.

In this section

• Renaming metadata groups (redeploy) on page 36

• Adding new metadata (redeploy) on page 37

• Renaming metadata (redeploy) on page 38

• Renaming document type resources (redeploy) on page 39

• Adding metadata groups (redeploy) on page 40

• Changing metadata values (redeploy) on page 41

• Enabling metadata in a context (redeploy) on page 41
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• Enabling metadata in a context (redeploy) on page 41

• Deleting document type resources (redeploy) on page 42

• Changes that require database manipulation on page 44

Renaming metadata groups (redeploy)

Consequences in databases

Consequences in StreamStudio

Database Consequences

Enterprise repository The following changes are applied to document types that include the 
renamed metadata group:

• The revision number is updated.

• The metadata group name is changed.

Runtime repository Metadata groups are not represented in the runtime repository.

StreamServe archive Metadata groups are not represented in the StreamServe archive.

Application Consequences

Composer Metadata groups are not displayed in Composer.

Composition Center The metadata group name is changed in Composition Center. Since 
only the name of the metadata group has changed, all included 
metadata remain unchanged in Composition Center.

Collector Metadata groups are not shown in Collector. This means Collector is 
not affected when you rename a metadata group.
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Adding new metadata (redeploy)

Consequences in databases

Consequences in StreamStudio

Database Consequences

Enterprise repository The following changes are applied to document types that include the 
metadata group with the new metadata:

• The revision number is updated.

• The new metadata is added.

Runtime repository The new metadata is added to the runtime repository.

Message storages
New metadata is added to a Message storage if:

• The document type of the Message storage includes the new 
metadata.

• The metadata is Message context enabled in the document 
type.

Post-processing storages
New metadata is added to a Post-processing storage if:

• The document type of the Post-processing storage includes the 
new metadata.

• The metadata is Post-processing context enabled in the 
document type.

StreamServe archive The new metadata is added to the StreamServe archive if it is Archive 
context enabled in the document type.

Application Consequences

Composer The new metadata is available in Composer.

Composition Center The new metadata is available in Composition Center.

Collector The new metadata is available in Collector if it is Archive context 
enabled in the document type.

The new metadata can only be used for documents that are archived 
after the metadata was added to the StreamServe archive.
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Renaming metadata (redeploy)

Consequences in databases

Consequences in StreamStudio

Database Consequences

Enterprise repository The following changes are applied to document types that include the 
metadata group with the renamed metadata:

• The revision number is updated.

• The metadata name is changed.

Runtime repository The metadata name is updated in the runtime repository.

Message storages
The metadata name is updated in the Message storages.

Post-processing storages
The metadata name is updated in the Post-processing storages.

StreamServe archive The metadata name is updated in the StreamServe archive.

Application Consequences

Composer • The metadata name is changed in the selection lists in 
Composer.

• The metadata name is not changed in already defined texts. 
This means these texts must be manually updated with the new 
metadata names.

Composition Center • The metadata name is changed in the selection lists in 
Composition Center.

• The metadata name is changed in already defined texts and 
rules.

Collector The metadata name is changed in all sections in Collector. The name 
change does not affect Collector searches. This means you can use 
the new name to search for documents that were stored in the 
StreamServe archive before and after the metadata was renamed.
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Renaming document type resources (redeploy)

Consequences in databases

Consequences in StreamStudio

Database Consequences

Enterprise repository • The revision number is updated for the document type.

• The document type is renamed.

Runtime repository The document type name is updated in the runtime repository.

Message storages
The name of the Message storage is changed.

Post-processing storages
The name of the Post-processing storage is changed.

StreamServe archive The document type name is updated in the StreamServe archive.

Application Consequences

Composer • The document type name is updated in Composer. 

• Since only the name of the document type is changed, all 
metadata connected to the document type remain unchanged in 
Composer.

Composition Center Since only the name of the document type is changed, all metadata 
connected to the document type remain unchanged in Composition 
Center.

Collector The document type name is updated in Collector. The name change 
does not affect Collector searches. This means you can use the new 
name to search for documents that were stored in the StreamServe 
archive before and after the metadata was renamed.
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Adding metadata groups (redeploy)

Consequences in databases

Consequences in StreamStudio

Database Consequences

Enterprise repository • The revision number is updated for the affected document 
types.

• The new metadata group is added to the affected document 
types.

• All metadata in the new metadata group are added to the 
affected document types.

Runtime repository All metadata in the new metadata group is added to the runtime 
repository.

Message storages
Metadata in the new metadata group is added to a Message storage if:

• The document type of the Message storage includes the new 
metadata group.

• The metadata is Message context enabled in the document 
type.

Post-processing storages
Metadata in the new metadata group is added to a Post-processing 
storage if:

• The document type of the Post-processing storage includes the 
new metadata group.

• The metadata is Post-processing context enabled in the 
document type.

StreamServe archive All Archive context enabled metadata in the new metadata group is 
added to the StreamServe archive.

Application Consequences

Composer All metadata in the new metadata group is available in Composer.

Composition Center All metadata in the new metadata group is available in Composition 
Center.

Collector The new metadata is available in Collector if it is Archive context 
enabled in the document type.

The new metadata can only be used for documents that are archived 
after the metadata was added to the StreamServe archive.
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Changing metadata values (redeploy)
You can change the value assignment type (No value, Static text, or Variable) as 
well as the actual value to assign to the metadata without affecting the repositories 
or StreamStudio applications.

Enabling metadata in a context (redeploy)

Consequences in databases

Consequences in StreamStudio

Database Consequences

Enterprise repository • The revision number is updated for the document types that 
include the new metadata group.

• The metadata value for the context in the document type xml is 
changed to true.

Runtime repository Message storages
All metadata enabled in Message context is added to the Message 
storage.

Post-processing storages
All metadata enabled in Post-processing context is added to the Post-
processing storage.

StreamServe archive All metadata enabled in Archive context is added to the StreamServe 
archive.

Application Consequences

Composer There are no consequences for Composer since you cannot enable/
disable metadata in this context.

Composition Center There are no consequences for Composition Center since you cannot 
enable/disable metadata in this context.

Collector All metadata enabled in Archive context is available in Collector. 
This metadata can only be used for documents that are archived after 
the metadata were enabled.
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Deleting document type resources (redeploy)

Consequences in databases

Consequences in StreamStudio

Database Consequences

Enterprise repository The document type is not removed from the enterprise repository. 
See Deleting document types in enterprise and runtime repository on 
page 43.

Runtime repository The document type is not removed from the runtime repository. See 
Deleting document types in enterprise and runtime repository on 
page 43.

Message storages
The Message storage for this document type is not removed from the 
runtime repository. To remove it from the runtime repository you 
must drop the storage using Database Administration Tool (DBAT).

Post-processing storages
The Post-processing storage for this document type is not removed 
from the runtime repository. To remove it from the runtime 
repository you must drop the storage using Database Administration 
Tool (DBAT).

StreamServe archive The document type is not removed from the StreamServe archive. To 
remove it you must use your DBMS.

Application Consequences

Composer If you delete a document type, it is removed from all related Message 
configurations. To enable this type of Message configuration in 
Composer you must assign a new document type to it.

Metadata used in texts and rules in Composer are connected to the 
deleted document type. This means you must update all texts and 
rules that include metadata from the deleted document type, and use 
metadata from the new document type instead.

Composition Center If you delete a document type, it is removed from all related Message 
configurations. To enable this type of Message configuration in 
Composition Center you must assign a new document type to it.

Templates affected by the change of document type need new 
document definitions in Composition Center.
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Deleting document types in enterprise and runtime repository
If you delete a document type resource, it is not deleted from the enterprise 
repository or runtime repository after Project export and deployment. To delete a 
document type from the repositories, you must delete it manually, for example 
from Control Center. Note that you delete the document type from the enterprise 
repository and runtime repository at the same time.

Note: You must have administrator privileges to delete document types.

Before deleting a document type from the repositories

Before you can delete a document type from the runtime repository, you must:

• Stop all applications in the application domain.

• Make sure the runtime repository contains no jobs related to the document 
type. You can use Database Administration Tool to delete jobs.

• Make sure the runtime repository contains no Messages in Message 
storages related to the document type. You can use Database 
Administration Tool to expire and delete Messages.

• Make sure the runtime repository contains no documents in Post-processing 
storages related to the document type. You can use Database 
Administration Tool to expire and delete documents.

• Make sure the runtime repository does not contain any persistent resources 
related to the document type. You can use Database Administration Tool to 
delete the resources.

• Make sure there are no documents, related to the document type, waiting to 
be archived. You can use Database Administration Tool to examine the 
archiving queue, and to retry to archive documents that failed to be 
archived.

• Make sure the runtime repository does not contain any saved Collector 
searches related to the document type. You can use Database 
Administration Tool to delete the saved searches.

• Make sure you have a complete backup of the runtime repository.

To delete a document type from the repositories

1 In Control Center, right-click the Site node and select Document Types. 
The Document Types dialog box opens.

Collector If you delete a document type, it is removed from all related Message 
configurations. To enable this type of Message configuration in 
Collector you must assign a new document type to it.

Documents archived before the change of document type are 
searched for using the old document type. Documents archived after 
the change are searched for using the new document type.

Application Consequences
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2 Select the document type you want to delete and click Delete.

Message and Post-processing storages

Message and Post-processing storages related to the deleted document type are 
also removed from the runtime repository when you delete the document type.

Changes that require database manipulation
The following changes cannot be applied to a document type unless a user with 
administrator privileges updates the repositories:

• Change the data type of metadata. See Changing the data type of metadata 
(redeploy) on page 45.

• Remove metadata:

– Metadata deleted (removed from metadata group). See Deleting 
metadata (redeploy) on page 46.

– Metadata groups removed from a document type. See Removing 
metadata groups (redeploy) on page 48.

– Metadata group deleted (removed from the resource set). See Deleting 
metadata groups (redeploy) on page 48.

• Disable metadata in a context. See Disabling metadata in a context 
(redeploy) on page 49.

Forcing updates into the runtime repository

If any of the changes described above must be applied to a document type, then a 
user with administrator privileges can force the updates into the runtime 
repository. See Forcing updates into the runtime repository on page 51.
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Changing the data type of metadata (redeploy)
Before you redeploy, you must:

• Stop all applications in the application domain.

• Make sure the runtime repository contains no jobs related to affected 
document types. You can use Database Administration Tool to delete jobs.

• Make sure the runtime repository contains no Messages in Message 
storages affected by the changed metadata. You can use Database 
Administration Tool to expire and delete Messages (do not drop Message 
storage).

• Make sure the runtime repository contains no documents in Post-processing 
storages affected by the changed metadata. You can use Database 
Administration Tool to expire and delete documents (do not drop Post-
processing storage).

• Make sure the runtime repository does not contain any persistent resources 
related to affected document types. You can use Database Administration 
Tool to delete the resources.

• Make sure there are no documents waiting to be archived. You can use 
Database Administration Tool to examine the archiving queue, and to retry 
to archive documents that failed to be archived.

• Make sure there are no saved Collector searches that include the changed 
metadata. If there are, you must remove the changed metadata from all 
affected searches in Collector.

• Make sure you have a complete backup of the runtime repository.

When you try to redeploy, you receive a message saying you cannot redeploy 
unless you force the update into the runtime repository. To do this you must have 
administrator privileges. See Forcing updates into the runtime repository on page 
51.
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Consequences in databases

Consequences in StreamStudio

Deleting metadata (redeploy)
Before you redeploy, you must:

• Stop all applications in the application domain.

• Make sure the runtime repository contains no jobs related to affected 
document types. You can use Database Administration Tool to delete jobs.

• Make sure the runtime repository contains no Messages in Message 
storages affected by the changed metadata. You can use Database 
Administration Tool to expire and delete Messages.

• Make sure the runtime repository contains no documents in Post-processing 
storages affected by the changed metadata. You can use Database 
Administration Tool to expire and delete documents.

• Make sure the runtime repository does not contain any persistent resources 
related to affected document types. You can use Database Administration 
Tool to delete the resources.

Database Consequences

Enterprise repository The following changes are applied to document types that include the 
metadata group with the deleted metadata:

• The revision number is updated.

• The metadata type is removed.

Runtime repository The metadata type is updated in the runtime repository.

Message storages
The metadata type is updated in all Message storages.

Post-processing storages
The metadata type is updated in all Post-processing storages.

StreamServe archive The old metadata is not removed from the StreamServe archive. It is 
still attached to already archived documents, but it cannot be used 
anymore in Collector searches.

Application Consequences

Composer The metadata cannot be used in already defined texts. This means 
these texts must be manually updated.

Composition Center The metadata cannot be used in already defined texts and rules. This 
means these texts and rules must be manually updated.

Collector The metadata cannot be used in Collector searches.
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• Make sure there are no documents waiting to be archived. You can use 
Database Administration Tool to examine the archiving queue, and to retry 
to archive documents that failed to be archived.

• Make sure there are no saved Collector searches that include the deleted 
metadata. If there are, you must remove the metadata from all affected 
searches in Collector.

• Make sure you have a complete backup of the runtime repository.

When you try to redeploy, you receive a message saying you cannot redeploy 
unless you force the update into the runtime repository. To do this you must have 
administrator privileges. See Forcing updates into the runtime repository on page 
51.
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Consequences in databases

Consequences in StreamStudio

Removing metadata groups (redeploy)
This has exactly the same impact as deleting metadata. See Deleting metadata 
(redeploy) on page 46.

Deleting metadata groups (redeploy)
This has exactly the same impact as deleting metadata. See Deleting metadata 
(redeploy) on page 46.

Database Consequences

Enterprise repository The following changes are applied to document types that include the 
metadata group with the deleted metadata:

• The revision number is updated.

• The metadata is removed.

Runtime repository The metadata is removed from the runtime repository.

Message storages
The metadata is removed from all Message storages and cannot be 
used anymore.

Post-processing storages
The metadata is removed from all Post-processing storages and 
cannot be used anymore.

StreamServe archive The deleted metadata is not removed from the StreamServe archive. 
It is still attached to already archived documents, but it cannot be 
used anymore in Collector searches.

Application Consequences

Composer • The metadata is removed from the selection lists in Composer.

• The metadata cannot be used in already defined texts. This 
means these texts must be manually updated.

Composition Center • The metadata is removed from the selection lists in 
Composition Center.

• The metadata cannot be used in already defined texts and rules. 
This means these texts and rules must be manually updated.

Collector The deleted metadata cannot be used in Collector searches.
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Disabling metadata in a context (redeploy)
Before you redeploy, you must:

• Stop all applications in the application domain.

• Make sure the runtime repository contains no jobs related to affected 
document types. You can use Database Administration Tool to delete jobs.

• If you disable metadata in Message context, make sure the runtime 
repository contains no Messages in Message storages affected by the 
changed metadata. You can use Database Administration Tool to expire and 
delete Messages.

• If you disable metadata in Post-processing context, make sure the runtime 
repository contains no documents in Post-processing storages affected by 
the changed metadata. You can use Database Administration Tool to expire 
and delete documents.

• If you disable metadata in Archive context, make sure there are no 
documents waiting to be archived. You can use Database Administration 
Tool to examine the archiving queue, and to retry to archive documents that 
failed to be archived.

• Make sure the runtime repository does not contain any persistent resources 
related to affected document types. You can use Database Administration 
Tool to delete the resources.

• If you disable metadata in Archive context, make sure there are no saved 
Collector searches that include the changed metadata. If there are, you must 
remove the changed metadata from all affected searches in Collector.

• Make sure you have a complete backup of the runtime repository.

When you try to redeploy, you receive a message saying you cannot redeploy 
unless you force the update into the runtime repository. To do this you must have 
administrator privileges. See Forcing updates into the runtime repository on page 
51.
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Consequences in databases

Consequences in StreamStudio

Database Consequences

Enterprise repository • The revision number is updated for the document types that 
include the disabled metadata.

• The metadata value for the context in the document type XML 
is changed to false.

Runtime repository Message storages
Metadata disabled in Message context can no longer be used.

Post-processing storages
Metadata disabled in Post-processing context can no longer be used.

StreamServe archive Metadata disabled in Archive context is not removed from the 
StreamServe archive. It is still attached to already archived 
documents, but it cannot be used anymore in Collector searches.

Application Consequences

Composer There are no consequences for Composer since you cannot enable/
disable metadata in this context.

Composition Center There are no consequences for Composition Center since you cannot 
enable/disable metadata in this context.

Collector Metadata disabled in Archive context cannot be used in Collector 
searches.
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Forcing updates into the runtime repository
If you have administrator privileges you can force updates into the runtime 
repository. This applies to the following types of changes:

• When the metadata type is changed.

• When metadata is removed:

– Metadata deleted (removed from a metadata group).

– Metadata groups removed from a document type.

– Metadata group deleted (removed from the resource set).

• When metadata is disabled in a context.

If you have made any of the changes above, and try to redeploy a Project in 
Control Center, you receive a message saying you cannot redeploy unless you 
force the updates into the runtime repository. In this case you have the option to 
click Cancel and cancel the action, or Force update to force the updates into the 
runtime repository and deploy the Project. Before you force the updates into the 
runtime repository you must verify the following:

• There are no running applications in the application domain.

• The runtime repository contains no jobs related to affected document types.

• The runtime repository contains no Messages in Message storages affected 
by the change.

• The runtime repository contains no documents in Post-processing storages 
affected by the change.

• The runtime repository does not contain any persistent resources related to 
affected document types.

• There are no documents waiting to be archived if metadata is disabled in 
Archive context.

• The runtime repository contains no saved Collector searches affected by the 
change.

• You have a complete backup of the runtime repository.
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GUI reference

In this chapter

• Metadata group resource reference on page 53

• Document type resource reference on page 56

Metadata group resource reference
In this section

• Metadata Group Editor on page 53

• Metadata definition dialog box on page 55

Metadata Group Editor
In the Metadata Group editor, you define which metadata to include in a metadata 
group. You also select the document type resources to connect the metadata group 
to.

Figure 14 The MetaData Group Editor – initial view

Setting Description

Share Opens the Document types view where you select the 
document type resources to connect the metadata group 
to.

Name The name of the metadata.

Data type The data type of the metadata.
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View menu commands

The View menu includes the commands described in the table below.

Document types view

In this view, you select the document type resources to connect the metadata 
group to.

Figure 15 The MetaData Group Editor – document types view

Export GUID The GUID of the metadata. Displayed only if enabled in 
View > Export GUIDs.

Opens the Metadata definition dialog box where you 
specify the name and data type of each metadata.

Opens the Metadata definition dialog box where you can 
edit the metadata settings.

Deletes the selected metadata.

Command Description

Toolbar Enables the toolbar.

Status Bar Enables the status bar.

Export GUIDs Displays the metadata GUIDs in the editor.

Setting Description
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Metadata definition dialog box
In the Metadata definition dialog box, you specify the name and data type of each 
metadata.

Figure 16 The Metadata definition dialog box

Setting Description

Auto-apply to all 
Document types

If selected, the metadata group is connected to all existing 
document type resources in the resource set that contains 
the metadata group resource. The metadata group is also 
automatically connected to all new document type 
resources created in the resource set.

Document type Select which existing document type resources to 
connect the metadata group to.

Setting Description

Metadata name The name of the metadata.

• The name must be unique. This means you must not 
use the same metadata name for metadata in the 
same or different metadata groups.

• The name should be descriptive since it is displayed 
to business users in StreamStudio.

Data type The type of data the metadata is intended for. You must 
select the appropriate data type – Date, Numeric, or 
Text. 
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Document type resource reference
In this section

• Document Type Editor – overview on page 56

• Document Type Editor – metadata values on page 58

• Document Type Editor – contexts on page 59

• Document Type Editor – sample files on page 61

Document Type Editor – overview
In the Document Type Editor, you assign values to metadata, and specify in which 
contexts to use the metadata.

Figure 17 Document type editor

Settings Description

Context drop-down 
list

Selects context to display. See Document type contexts 
on page 11.

Metadata groups All metadata groups added to the document type.
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Value assignments table

See Document Type Editor – metadata values on page 58 and Document Type 
Editor – contexts on page 59.

Metadata value section

See Document Type Editor – metadata values on page 58.

Tools menu commands

The Tools menu includes the commands described in the table below.

View menu commands

The View menu includes the commands described in the table below.

Document Type Metadata tab

On this tab you assign values to the metadata (see Document Type Editor – 
metadata values on page 58) and specify the context settings for the metadata (see 
Document Type Editor – contexts on page 59).

Sample Resource tab

On this tab you assign sample files to the document type. The sample data in the 
files is used when previewing documents in StreamStudio. See Document Type 
Editor – sample files on page 61.

Displays document type information:

• Document type name.

• Document type revision.

• Document type GUID (if enabled in View > Export 
GUIDs).

Validates metadata. Checks if metadata with identical 
names is assigned to the document type.

Command Description

Validate Metadata Checks if metadata with identical names are assigned to 
the document type.

Command Description

Toolbar Enables the toolbar.

Status Bar Enables the status bar.

Export GUIDs Displays the document type and metadata GUIDs in the 
editor.

Settings Description
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Document Type Editor – metadata values
On the Document Type Metadata tab, when the top node in the context drop-down 
list is selected, you can assign values to the metadata added to the document type. 
First you must select a metadata group to display its metadata. Then you select 
metadata and specify the metadata values.

Figure 18 Document type editor – metadata assignment settings

Value assignments table

This table displays the values assigned to the metadata in the selected metadata 
group.

Column Description

Name The name assigned to the metadata. 

Data type The data type assigned to the metadata.

Value The value of the metadata. The value is assigned per 
document type (see Metadata value section below).

Archive Shows whether the metadata is enabled in the Archive 
context. This is defined per document type.

Message Shows whether the metadata is enabled in the Message 
context. This is defined per document type.

Post-processing Shows whether the metadata is enabled in the Post-
processing context. This is defined per document type.
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Metadata value section

In this section you assign the value to the metadata selected in the Value 
assignments table. See Metadata values on page 9 for information about valid 
values.

Document Type Editor – contexts
On the Document Type Metadata tab, you can specify whether to include 
metadata in different contexts.

Export GUID The GUID of the metadata (if enabled in View > Export 
GUIDs).

Setting Description

No value Used with E-Invoice Center where metadata values are 
assigned by filters.

Static text Used when the metadata has a fixed value.

Variable Used when the metadata value is assigned by a variable.

Value The value to assign to the metadata (static text or 
variable).

Column Description
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A document type is divided into different contexts (see Document type contexts 
on page 11). For each context you must specify which metadata in the document 
type resource to use.

Figure 19 Document type editor – metadata context settings

Setting Description

Context drop-down 
list

Selects the context to display and edit. See Document 
type contexts on page 11.

Value assignments 
table

Enables/disables metadata in the selected metadata group 
and context.

Select All Enables all metadata in the selected metadata group and 
context. 

Clear Selection Disables all metadata in the selected metadata group and 
context. 
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Document Type Editor – sample files
On the Sample Resource tab, you assign sample files to the document type. The 
sample data in the files is used when previewing documents in StreamStudio.

Figure 20 Document type editor – sample resource settings

Icon Description

Adds a new sample file to document type.

Edit the selected sample file. You can select a new 
sample file and edit the description.

Deletes the selected sample file.
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